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1 INTRODUCTION 
 
 
AutoFlowChart is a tool for designing flowcharts with unlimited numbers of connected 
documents and multiple levels of flowcharts.  
 
Various types of charts can be designed and applied with connections to any file type on the 
local computer, the company network or even the Internet. Typical examples are 
instructions, routines, manuals, images, video files, audio files etc. 
 
To visualise a company’s processes we create an easily comprehensible view of how the 
company works. Complicated flows are made easy and everybody can see connections that 
otherwise would be difficult to understand. 
 
Fields where AutoFlowChart is the perfect tool to use: 
 

§  Industries  
§  Hospitals 
§  Schools / Educational facilities 
§  Construction industry 

 
AutoFlowChart can be used for various tasks: 
 

§  Machine line with connected instructions and manuals for maintenance 
§  To visualise all the processes in the company e.g. purchasing, sales, production etc. 
§  The company computer network with connected manuals to document hardware and 

software  
§  Flowcharts for individual articles that describe handling and control 
§  Education with connection to images and instructions etc. 
§  To show step-by-step progression through a procedure or system 

 
AutoFlowChart is perfect to simplify and design: 
 

§  Environmental standards like ISO 14001 
§  Quality systems like ISO 9000, QS9000, ISO/TS 16949 etc.  
§  Educational systems for new employees 
§  Maintenance on machines and manufacturing lines 
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2 LOG IN 
 
 

 
 
AutoFlowChart can be started as a stand-alone module or from our project system AutoFlow 
e-toolkit. The AutoFlow password is the same as for logging on to AutoFlowChart. 
 
Note that usernames and passwords are case sensitive! 
 



AutoFlowChart – with exercises 

 

 - 6 - 

 
3 AUTOFLOWCHART: OVERVIEW 
 
 
AutoFlowChart can be started in three ways: 
 

§  User with rights to browse to another flowchart 
§  User without rights to browse to another flowchart 
§  User with design rights with possibilities to create new and change 

existing flowcharts 
 
The alternatives in the menu are dependent on the user’s rights. The following image shows 
a normal user without design rights. 
 

 
 
If the user has design rights design mode can be chosen from the edit menu. The following 
shows the screen for a user with design rights. 
 

 
 
A user must have browse rights to be able to see the alternative “Available Flowcharts”. 
The alternative “Information” shows the information for the active flowchart. Drawing tools 
are only visible in design mode. 
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4 MENUS IN USER MODE 
 
 
File menu 

 
 
>Available Flowcharts shows all the flowcharts in the system. 
 
>Page Flow = Page Layout handles the possibility to print a flowchart over many pages. 
 

 
 
It is possible to print a flowchart on one page disregarding the actual size of the flowchart. 
The program will resize the flowchart to make it fit into one page. With the Page Flow 
utility it is possible to print a flowchart over any number of pages. The printed pages can 
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then be glued or taped together making it possible to present large flowcharts even if you 
only have access to an A4-printer. 
 
Select either horizontal or vertical spread and then choose “Update”. AutoFlowChart will 
automatically calculate the number of pages needed in the direction not chosen. Margins and 
settings regarding page headers are also available. 
 
>Page set-up is a possibility to set up the printer. 
 
>Print will print the flowchart. In some rare cases (very old printers) the flowchart cannot 
be printed. 
 
>Print preview shows a preview of the printout. If the settings in Page flow are set for 
multiple pages this can be viewed here. 
 
>Exit the program. 
 
 
Edit menu 

 
 
 
>Design mode can be accessed by users with sufficient rights. To shift between normal and 
design mode use Ctrl+D. 
 
>Zoom rescales the flowchart from 25% - 500%. Keyboard shortcuts Ctrl + F1 – F8. 
 
>Language can be chosen if you have a multilingual version installed. 
 
 
Help menu 

 
 
>Help with table of contents and search possibilities. 
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Left column menu 

 
 
>Information shows the information for the active flowchart. 
 
>Available Flowchart shows all the available flowcharts if the user has browse rights.  
 
>Changing label text is possible for all the fields except for the four at the bottom. 
 

 
Enter design mode 
Click on the lead text to change 
Type the new lead text 
Press enter to save the new text 
 
Note! Only the first seven lead texts can be changed 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
>Hiding a fill field will make the field invisible. 
Do as above but delete all text in the yellow text box and then press enter  
 
 
Note! Changing label texts is an overall setting
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5 MENUS IN DESIGN MODE 
 
 
This chapter will only present the options in design mode. 
 
File menu 

 
 
>Available Flowcharts  

 
 

“Insert” will insert the selected flowchart into the active one. 
 

Note! The delete option is available only from this screen. 
 
>Import flowchart means that a file with the extension .AFC (AutoFlowChart internal file 
format) can be imported. The AFC format is created when choosing “Export flowchart” so 
this makes import and export of flowcharts possible between AutoFlowChart users.  
 
>Export flowchart an AFC file will be created and can then be imported by another user of 
AutoFlowChart (e.g. between two different companies). 
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1. Choose Export flowchart from the File menu to see this screen. Choose the 

flowcharts to export. Choose if connected documents should be exported. 
Browse to find the directory to export to. 

  
 
 

 
 

2. Type a suitable name and save the flowchart. 
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3. Now choose if connected files should be exported as well. Click export to finish 
exporting. 

 
 
 
>Export to HTML code is an option to create interactive HTML-based flowcharts to be 
published on the Internet or on your local intranet. All files associated with an HTML export 
will be saved in a directory of your own choice. That directory can be e-mailed or burned to 
a CD. All the information will be contained in the directory or on the CD and the flowcharts 
can be accessed, with full functionality, from a browser.  
 
Only one flowchart at a time can be exported to HTML code. Choose the same export 
directory if the flowcharts are connected and belong to the same system. Choose “Include 
connected files” if files and/or images should be exported. By not choosing “Include 
connected files” all the files and/or pictures are linked and this is specially used for internal 
use on an intranet. Use browse to choose the directory to export to. It is also possible to 
create a directory by typing the name directly after the path. The screen below shows that 
the directory “Validering” has been added manually. 
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>Export to BMP, JPG or GIF to be able to e-mail a flowchart or to paste it into another 
office application. 
 

Note! Keyboard shortcuts after each menu choice. 
 
Edit menu 

 
 
>Documents show all the files that are connected to all the flowcharts or to a specific 
flowchart. In the list displaying documents, double-clicking on a list object will open the 
document. Right-click on a row to create a new issue or to view obsolete documents. 
 

 
Select the document by clicking on its name and right-click to view the popup menu. 
 

§  Create new issue will copy the document a rename it by adding _XXX to the name. 
The original document will keep its original name and place and are now possible to 
edit by double clicking on the row. 
Note! Obsolete documents are saved in a child directory named obsolete 
 

§  View obsolete issues will display all obsolete documents in a list. It is possible to 
view there contents by double clicking. 

 
>Cut the selected object (enabled when an object has been selected). 
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>Copy the selected object (enabled when an object has been selected). 
 
>Paste the copied object. The pasted object will appear on top of the one just copied. 
 
>Select all will select everything on the screen including arrows and images. 
 
>Chart properties set the properties for all the charts not just the active one. Choose “Show 
grid” to make the grid visible on all the charts. Grid size can be set from 1 and upwards. The 
default font is set for lines and for drawn boxes (objects). Existing charts are not affected. 

 
 
 
Help menu 

 
 
The Help menu is the same in both user and design mode. 
 
 
Left column menu 

 
 
>Drawing tools - See chapter about drawing tools. 
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Exercises chapters 3–5 

For users with design rights 
 
 

⌦ Log on to the program. A flowchart will appear in the right-hand part of the screen. 
 

⌦ Note the different menus and the alternatives on the File, Edit and Help menus. 
 

⌦ Note the options on the left-hand menu i.e. Available Flowcharts and Information. 
 

⌦ Choose Design mode on the Edit menu. What options are added regarding functions 
and choices? 
 

⌦ Click on a flowchart on the left-hand menu Available Flowcharts. Now change the 
information for the active flowchart. Open another flowchart by clicking on its name 
and then go back to the one you changed and note that the information has been 
saved automatically. 
 

⌦ Enable the grid and set the spacing to 20 pixels.  
 

⌦ Choose print but first click Page Setup on the File menu, and select Landscape or 
Portrait. Select Page Flow and choose to print on four pages vertically and click 
Update and then Close. Check the flowchart and note the dotted lines that indicate 
the number of pages. 
 

⌦ Export a flowchart to a directory on the hard disk. Choose not to include connected 
files and then use your first name when naming the flowchart. 
 

⌦ Import the flowchart that you just exported and check that it is visible among the 
Available flowcharts. 
 

⌦ Select to export a flowchart to HTML format and name the destination directory 
TEST. The TEST directory shall be situated on your local hard drive. 

 
⌦ Export a flowchart as a GIF image to the same directory as above. 
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6 TOOLBAR 
 
 

 
The icons have the following functions: 
 

§  Create a new flowchart 
§  Open an existing flowchart 
§  Save all changes (changes are automatically saved when navigating to another 

flowchart or on exiting the program)  
§  Print preview 
§  Cut 
§  Copy 
§  Paste 
§  Delete the selected object(s) 
§  Undo last deletion (Note! Last deletion only) 
§  Send to front 
§  Send to back 
§  Pointer to choose/move objects 

 
§  Draw 
§  Connect, the tool is used to connect two objects with a line with or without an 

arrowhead 
§  Properties, with this tool selected the properties will appear when clicking an object 

or a line/arrow  
 

Note!  
The tools in bold will stay active on double-clicking them. On single-click the 

Pointer will be the active tool after using the Draw, Connect or Properties tool. 
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7 DRAWING TOOLS 
 
 
The Drawing Tools are only available in design mode. The tools can be grouped in different 
categories (depending on software version). 
 

 
 
Note! The groups can vary with the software version of the program. 
 
>Standard 
Normally showing all the geometrical tools. 
 
>Extended 
Availability depends on program version. Normally it contains more complex geometrical 
tools. 
 
>Icons 
When installed by a consultant, logos and icons can be inserted into a tool group. 
 
>All  
Displays all the available drawing tools. 
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8 TO DRAW AN OBJECT 
 
 
Select the drawing tool you want and hold the left mouse button to draw the object. Change 
size by clicking and dragging the handles of the object. 
 

Note! The draw icon in the toolbar stays selected if you double-click it.  
 
 

Exercises chapters 6 – 8 
 For users with design rights 

 
 

⌦ Create a new flowchart. Now decide what the chart should be like. 
 

⌦ Enter the information for the new flowchart into the left-hand part of the screen. 
 

⌦ Enter the Edit menu and now choose Chart properties to enter the headline font 
for the line and object. Choose if you want a visible grid or not. 
 

⌦ Select the drawing tool (double-click to make the tool stay active) and now select 
the shape from the left part of the screen. Draw the number of objects you need and 
drag them to the appropriate positions. 
 

⌦ Create a few more objects by copying and pasting. 
 

⌦ Delete an object and immediately choose Undo last deletion. Note that the undo 
function only will undo the last deletion. 
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9 OBJECT PROPERTIES 
 
 
Everything that has been drawn in a flowchart is called an object. Any image in a flowchart 
is also considered as an object. 
 

Rectangle  
Triangle 
Arrow 
Parallelogram 
Images, icons and logos 

 
An object has different properties; colour, width, height etc. The properties can be selected 
on creation or at a later time. 
 
The Object menu is displayed on right-clicking:  

 
 
 
Cut to delete or paste elsewhere 
Copy and paste elsewhere 
Paste a copied or cut object 
Delete object 
Bring to front of all the other objects 
Bring to back behind all the other objects 
Documents that are connected to this object 
Properties for this particular object 
 
 
 
 
 
 

 
Documents indicate documents that are connected to the selected object. Open a connected 
document by double-clicking its name on the display list. 
 
Properties has three different tabs with various possibilities to handle the object’s data and 
information: 
 
Tab - Information 

§  Object Name – the visible name of the object 
§  Part Number – this field is used when AutoFlowChart is used in cooperation with 

our other products like Quality Quartet or AutoFlow. In these cases the field will 
connect directly to the same part number in the FMEA-, control plan- or project 
module. 

§  Issue – this field is used only as above. 
§  Comments – comments or other information about the object. 
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§  Hide popup menu from this object – select this to avoid all action when clicking on 
the object. 

 
Tab - Geometry 

§  Shape – the actual shape 
§  Image – selection of an image 
§  Line Colour – select transparent to hide line 
§  Fill Colour – select transparent to display text only 
§  Text justification – horizontal or vertical positioning of object text 
§  Text Colour – select text colour 
§  Font – select font for the object text 
§  Position and size – the manual way to exactly position the object 

 
Tab - Connections 

§  Connection – shows all the defined connections on the popup menu 
§  New – creates a new line on the menu to connect a document, flowchart or a program 
§  Name – name of the connection (appears on the object’s popup menu) 
§  Copy – copy the selected connection 
§  Delete – deletes a connection 
§  Up – moves the connection upwards 
§  Down – moves the connection downwards 
§  Flowchart – click here to connect another flowchart to the connection 
§  Select chart – click to select another chart from a selection window 
§  Menu – an object menu row can consist of a submenu for grouping similar 

documents (only valid for the ten upper menu rows) 
 
What is a Menu? 
A connection is normally placed on the object’s Main menu and will have a unique 
menu row. A menu row can also function as an alternative for grouping connections 
on a submenu. Select the pull-down menu next to “Main” and name each of the 
submenu headers you want to use. It is now possible to create as many connections 
as needed and thereafter choose which submenu it should belong to. The number of 
rows on the main menu and the submenus are unlimited. 
 

§  Command/Document – select this to connect a document, it also activates the “Insert 
filename” and “Command” 

§  Insert filename - select this option to browse for the document to connect 
 
 
Explaining "Command" and "Insert filename": 
It is possible to connect a program or a document. Select “Insert filename” to find 
the program or document to connect and click open to insert your choice in the 
“Command” field.  
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This connection will start the file Policy.doc 

 
 
 

Important when connecting a .DOT file 
If a .dot file is connected the system will normally open 

Document1.doc!  
To start an XLS file and connect it to a special worksheet 

 "G:\af99\ArtNo\Specialfiles\xlfile.xls <5> ". This will open the file 
xlfile.xls and invoke worksheet number 5 regardless of the name of the 

worksheet. Note the empty space between the signs > and ”. 
To start a particular page in a Word document 

 "G:\af99\ArtNo\Specialfiles\MANUAL.DOC <5> ". This will open the 
file MANUAL.DOC and thereafter display page number 5. 

 
 

Note! To open a web site enter for example: 
 http://www.national-netforms.com 

 
 
Note! To write regular text without a box on a flowchart  
To write regular text somewhere on the flowchart is another field of use for objects. This is 
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performed in the exact same way as when creating an object except for the ticking of 
transparent line and fill colours. What you actually get is an object where only the text is 
visible. The object can be formatted and moved as every other object. In addition to this you 
also tick ”Hide pop-up menu for this object” under the tab “Information” to remove the 
text’s character of being an object.  
 
 

Exercises chapter 9 
 
 

⌦ Find the flowchart you started working on in exercises chapters 6-8. You are going 
to do some extended work on your objects. 
 

⌦ Every object is going to receive a number of attributes. At first go to the tab 
“Geometry” to design the appearance of all the objects. 
 

⌦ Then you go on to the tab “Information" and fill in the names of the objects. Also fill 
in possible commentaries that might be interesting to yourself or to those who are 
going to use the flowchart in the future. 
 

⌦ Eventually you turn to the very last tab “Connections”. Now your task will be to 
connect all the relevant files to each and every one of the objects. In case you don’t 
have proper working material to use, find any possible files on your computer. The 
main thing is for you to understand how this function works. 
 
Make sure you have a DOC file (Word-document), an XLS file (Excel-document), a 
PDF file (Acrobat-document) and an HTML file (web page). Use the Internet and 
find a page to download. Open Internet Explorer, visit an interesting page, on the 
menu in IE you choose ”Save as” to save the web page. Now you will have an 
HTML file along with a folder including images and possible CSS files. 
 

⌦ When you begin there will be no connections created. You will have to create a new 
connection. Name the connection to find how it will appear in the field 
“Connections”. Start off with a DOC file. Browse for the file i.e. the Word document 
and choose open.  
 
Make another two connections. At first you connect the HTML file you downloaded 
earlier. The second connection is supposed to take the user straight out on the 
Internet  (e.g. http://www.national-netforms.com). Choose the exact same web page 
you visited at the earlier occasion when you downloaded a page. 
 

⌦ Now you continue working on the objects giving them various connections. Assign 
program’s used to open the files for some of them, while only indicating the file for 
others. 
 

⌦ Return to one of the objects and create another connection. This time though, the 
connection is to end up on a submenu. You name the submenu in the second field 
below “Menu”. This name will be the group name for the underlying connections i.e. 
the options that you see on the menus for the different objects. 
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⌦ Add some regular text somewhere on the flowchart. 
 

⌦ Shift to user mode to understand what the menus of the flowchart would look like to 
another user. Notice in particular the differences between the HTML file to which 
you connected on your hard disk/server versus the HTML file on the Internet.  
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10 HOW TO DRAW AN ARROW 
 

 
You select the arrow icon in the toolbar at the top to draw a 
connection/arrow. When you move the mouse over an object in this 
mode, holders with a circle and dashed lines will be activated on the 
object. 
 

Use the left mouse button to get hold of the circle to draw the line to any optional object. 
 

Note! The arrow tool in the toolbar stays activated if you double-click it 
otherwise the active tool will revert to the selection tool.  
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11 ATTRIBUTES OF AN ARROW 
 
 
The arrow menu looks almost the same as that of the objects. The menu appears if you right-
clock on an existing arrow that connects two objects. There is one difference though 
compared to the object menu i.e. “Attributes”. 

 
 
There are two different ways of showing arrows that connect two objects in AutoFlowChart. 
By default the program calculates the best way between two objects. There may be cases 
when this is not the most suitable or desirable kind and for this occasion there is the 
possibility of creating a straight arrow. 
 

§  Headings 
o Beginning of line - places text at the beginning of the arrow. 
o End of line - places text at the end of the arrow. 
o Alignment - text is aligned relative to the position of the arrow. 

 
§  Line style 

o Line colour – the colour of the selected line. 
o Text colour – the colour of the heading. 
o Font – choose the font of the heading. 
o Width – the width of the arrow line could be set from 1 to 6. 
o Straight line – makes the arrow straight. 
o Hide arrowhead – removes the arrowhead. 

 
§  Nodes 

o Starting point – choose the position on the object where the arrow begins. 
o Shift – by default the arrow begins right in the middle of the selected side, but 

to create easily-understood/distinct flowcharts you could adjust this position 
upwards/downwards or right/left to a value of – 50 to + 50%. 
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o Finishing point – choose where the arrow ends. 
o Shift – the same as above. 

 
 

Exercises chapters 10 - 11: 

 
 

⌦ Now you are going to connect all your objects to each other except regular text if 
any. You use the arrow tool to do this. Make sure you double-click the arrow tool 
when starting not to have to select the tool for every separate arrow. 
 

⌦ Once the arrows have been created, access “Attributes” for every arrow to define line 
colour and width. Hide one of the arrowheads and give a straight line to another. 
 

⌦ Give a descriptive heading to an arrow. Notice how you can change the position of 
the heading and format its text colour as well as its font. 
 

⌦ Change the starting points and the finishing points of some of the arrows.  
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12 SHOW IMAGES ON A FLOWCHART 
 
 
AutoFlowChart can display ordinary images or photos instead of geometrical figures. The 
program functions with most image formats. 

 
To substitute a figure for an optional 
image you right-click on the object. You 
select “Attributes” and the tab 
“Geometry” and then you choose the 

alternative “Image”. Here you click the icon with three dots to the right of the empty field 
and browse to the image you want to use. Choose to open it. Now you select the tab 
“Information” to remove the text in the field “Object name”. In case you want to use text, 
adjust its position horizontally/vertically under the tab “Geometry” to make it visible. Now 
the image will be connected to the present flowchart. 
 
 

Exercises chapter 12 
 
 

⌦ If you have access to your company’s logo (if not use the Netforms logo) place it in 
the top right-hand corner on your flowchart. An information box about the company 
is to be displayed if you click the logo in user mode. The name of the company is to 
be written in plain text below the logo. 
 

⌦ Substitute one object’s geometrical figure for a regular image, which you either 
download from the Internet, or a image that you have access to on your hard disk. 
 

⌦ Your flowchart is now finished and you are supposed to print it but also generate an 
HTML output. Firstly you will print the flowchart in a way that makes it cover two 
pages horizontally. Make relevant configurations below “Print setup”. In the print 
dialog box select the page orientation landscape or portrait and then below "Page 
Flow” adjust the number of pages that the printout is meant to cover. Remember to 
check how the flowchart’s canvas size will be divided on the print output. 
 

⌦ Secondly export the flowchart to HTML format. Make the export end up on your 
desktop in a folder that you name yourself. Include all the connected files in the 
export. Go to the explorer on your computer and find the relevant folder and click 
index.HTML or alternatively open Internet Explorer and browse to index.HTML in 
the export folder. 
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13 CONNECTING TO AUTOFLOW 
 
 
AutoFlowChart is an integrated part of AutoFlow e-toolkit and can easily be started from 
any of the AutoFlow checklists. AutoFlowChart will search for the article number used in 
the AutoFlow checklist. 
 
To start AutoFlowChart from AutoFlow you choose to edit the checklist in AutoFlow and 
then select “Connect program’s”. Only the first line should contain the following command; 
X:\AF99\FLOWCHART.EXE. X means the company’s mapped unity that contains 
AutoFlow-related files. This line will start AutoFlowChart without having to log on. The 
flowchart of the active article number in AutoFlow will be displayed if it exists. 
 
 
Note! AutoFlow is only available in Europe  
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14 ADVANCED FUNCTIONS 
 
 
Command-line argument 
 
AutoFlowChart can be started with different arguments which means that a flowchart can be 
started from your desktop. A typical way of using this utility would be when starting a 
specific flowchart that belongs to a certain department or division.. 
 
Syntax for AutoFlowChart: 
 
FLOWCHART.EXE –N –I –U –P 
 
-N = article number that is to be displayed in AutoFlowChart 
-I = edition (if any) of the article number 
-U = username 
-P = password 
 
The following example makes AutoFlowChart start without logging on and then edition two 
of article number 531105 will be displayed: 

FLOWCHART.EXE –N 531105 –I 02 –U admin –P franc  
(username = admin and password = franc) 
 
Note! One or many command-line arguments can be omitted e.g. –U for username or –P for 
password, which means that the program starts with the selected file but logging on will be 
required. 
 
What follows makes AutoFlowChart start and then after logging on displays the flowchart 
number “1234567” in the field “Article number”: 

FLOWCHART.EXE –N 1234567 
 
Notice that the example requires the user’s logging on in the ordinary way. 
 

Note! Letters and spaces can be used in the field “Article number”.  
 
How to use tags 
 
A tag is an expression that you write on the line “Command” below the tab “Connections”. 
A tag will be substituted for something else when run. 
There are two different tags to use in AutoFlowChart: 
<PART> 
<ISSUE> (to be used only with Quality Quartet) 
 
What follows starts a file named 531105.doc in the folder C:\AF99 
C:\AF99\<PART>.doc 
 
The tag <PART> will be substituted for the content of the field “Article number” which in 
this particular example would be 531105 when run  
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15 SETTINGS FOR USERS (IN THE PROGRAM USERADMIN) 
 
 
Use the system’s usernames and passwords (system data provided at delivery). 
 
Notice that at least one user must have permission to use UserAdmin. 
 
Settings for users 

 
 
>New – to add users. 
 
>Delete – to delete users. CAN’T BE UNDONE! 
 
>Username – the name to use to log in. 
 
>Password – the password to use to log in. 
 
>Real name – the user’s full name. 
 
>Signature – the user’s signature (only in the program AutoFlow). 
 
>Preferred language – the standard language of the program. 
 
>User is disabled from logging in – the user will be deleted and can no longer log in. 
 
>Rights – configurations of rights in the various parts of the program’s. 
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16 IF YOU NEED HELP OR SUPPORT 
 
 
If you have a valid support agreement you will get help according to the extent of the 
agreement. 
 
Telephone: +46 35 182838 
Telefax: +46 35 407 61 
E-mail: support@national-netforms.com 
 
The help system has been created by Netforms AB 
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17 STUDENT VERSION, LIMITATIONS ETC. 
 
 
The student version lacks the function of exporting to HTML format but except for this it is 
a full version of AutoFlowChart.  
 
To add efficiency to an environment where hundreds of students draw their own flowcharts, 
only those that have been created by the student for the student will be visible to him/her.  
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18 INTEGRATION OF THIRD-PARTY APPLICATIONS 
 
 
Doc Applications (document management etc.) 
AutoFlowChart can cooperate with DocApplications in design mode as well as in user 
mode. Read more about this the DocApplications web site http://www.docassist.se. 
 
Design mode: To create a relationship in DocApplications concerning an a certain box 
(object) that has been drawn in AutoFlowChart. To activate DocApplications a menu row 
must be created that begins with ”DA ” (DA and a space). Use optional text after the space. 
 
Choose “Attributes” on the pop-up menu of an object to create the menu row above. 
 
What follows is a valid menu row name: DA testprotocol 
What follows is an invalid menu row name: DA_testprotocol 
 
When the menu row has been created you open DocApplications by clicking “Insert file 
name”. Now it is possible to create the relationships (children) that are to be connected to 
the active object in AutoFlowChart. 
 
User mode: When the user clicks the menu row that begins with “DA …”, the 
DocApplications ASP-page will be displayed in the web browser along with the connected 
documents in PDF-format. 
 
Note! The DocApplications ASP-module must be installed and accessible in the system 
to make the integration work properly. 
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19 FREQUENTLY ASKED QUESTIONS 
 
 

1. How do you close a flowchart? 
You do not, instead you open an existing flowchart or start a new one and 
automatically the first flowchart closes. 
 

2. How do you rename a flowchart after having turned it into an HTML file i.e. 
having exported it to HTML-format? 
Do not do that, instead it must keep the number.HTML it received in the export. 
 

3. Why do certain inserted files get quotation marks? 
Regular documents do not get quotation marks while EXE files do, as they are 
program’s. 
 

4. How do you delete a flowchart? 
Go to “File” – “Available flowcharts”. Here it is possible to delete all the flowcharts 
except for the one that is presently open. If that is the one you want to delete, you 
will have to open another flowchart before deleting. 
 

5. What happens if I make a connection to an HTML file on my hard disk? 
You will have no problems viewing the page in AutoFlowChart as long as you work 
on the same hard disk or server, but only the HTML file itself will be exported to the 
export folder when you choose “Export to HTML”. This actually means that all the 
images and other files that are linked to the HTML file will be omitted. A better 
solution is to connect directly to the web address. 
 

6. What do I do to remove small particles that occur when I move an arrow from 
one place to another? 
Just click on the arrowhead. You could also try moving the arrowhead a bit and then 
back again. 
 

7. I just want plain text without any geometrical figures. What do I do? 
You do the exact same thing as you do when creating objects. The only difference is 
that you tick “Transparent line and fill colours”. What you get is an object where 
only the text is visible. The object can be formatted and moved as every other object.  
 

8. Why can’t I undo things? 
This button does not function the way a Windows undo-button does. In this program 
you can only undo your latest deletion. 
 

9. What is an AFC file? 
It is an AutoFlowChart file i.e. the program’s own file format. The file extension that 
is associated with AutoFlowChart. When exporting a flowchart, you get an AFC file. 
 

10. When I click on an object on a flowchart that has been exported to HTML, I 
cannot close the menu that opens. 
Just click on the object again and the menu will close automatically. 
 


